(infineon

Please note that Cypress is an Infineon Technologies Company.

The document following this cover page is marked as “Cypress” document as this is the
company that originally developed the product. Please note that Infineon will continue
to offer the product to new and existing customers as part of the Infineon product

portfolio.

Continuity of document content

The fact that Infineon offers the following product as part of the Infineon product
portfolio does not lead to any changes to this document. Future revisions will occur
when appropriate, and any changes will be set out on the document history page.

Continuity of ordering part numbers

Infineon continues to support existing part numbers. Please continue to use the
ordering part numbers listed in the datasheet for ordering.

www.infineon.com



& CYPRESS

-— EMBEDDED IN TOMORROW™

CYWO54907AEVAL1TF

Evaluation Kit User Guide

Document Number: 002-22338 Rev. *A

Cypress Semiconductor

An Infineon Technologies Company
198 Champion Court

San Jose, CA 95134-1709
WWW.Cypress.com
www.infineon.com


www.cypress.com
https://www.infineon.com/

&= CYPRESS

~amp> EMBEDDED (N TOMORROW

Copyrights

© Cypress Semiconductor Corporation, 2018-2020. This document is the property of Cypress Semiconductor Corporation
and its subsidiaries ("Cypress"). This document, including any software or firmware included or referenced in this document
("Software"), is owned by Cypress under the intellectual property laws and treaties of the United States and other countries
worldwide. Cypress reserves all rights under such laws and treaties and does not, except as specifically stated in this para-
graph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights. If the Software is not
accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of
the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to subli-
cense) (1) under its copyright rights in the Software (a) for Software provided in source code form, to modify and reproduce
the Software solely for use with Cypress hardware products, only internally within your organization, and (b) to distribute the
Software in binary code form externally to end users (either directly or indirectly through resellers and distributors), solely for
use on Cypress hardware product units, and (2) under those claims of Cypress's patents that are infringed by the Software
(as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware
products. Any other use, reproduction, modification, translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE. No computing device can be absolutely secure. Therefore, despite security measures implemented in Cypress hard-
ware or software products, Cypress shall have no liability arising out of any security breach, such as unauthorized access to
or use of a Cypress product. CYPRESS DOES NOT REPRESENT, WARRANT, OR GUARANTEE THAT CYPRESS PROD-
UCTS, OR SYSTEMS CREATED USING CYPRESS PRODUCTS, WILL BE FREE FROM CORRUPTION, ATTACK,
VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (collectively, "Secu-
rity Breach"). Cypress disclaims any liability relating to any Security Breach, and you shall and hereby do release Cypress
from any claim, damage, or other liability arising from any Security Breach. In addition, the products described in these mate-
rials may contain design defects or errors known as errata which may cause the product to deviate from published specifica-
tions. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without further
notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described in this
document. Any information provided in this document, including any sample design information or programming code, is pro-
vided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test
the functionality and safety of any application made of this information and any resulting product. "High-Risk Device" means
any device or system whose failure could cause personal injury, death, or property damage. Examples of High-Risk Devices
are weapons, nuclear installations, surgical implants, and other medical devices. "Critical Component" means any compo-
nent of a High-Risk Device whose failure to perform can be reasonably expected to cause, directly or indirectly, the failure of
the High-Risk Device, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and
hereby do release Cypress from any claim, damage, or other liability arising from any use of a Cypress product as a Critical
Component in a High-Risk Device. You shall indemnify and hold Cypress, its directors, officers, employees, agents, affiliates,
distributors, and assigns harmless from and against all claims, costs, damages, and expenses, arising out of any claim,
including claims for product liability, personal injury or death, or property damage arising from any use of a Cypress product
as a Critical Component in a High-Risk Device. Cypress products are not intended or authorized for use as a Critical Compo-
nent in any High-Risk Device except to the limited extent that (i) Cypress's published data sheet for the product explicitly
states Cypress has qualified the product for use in a specific High-Risk Device, or (ii) Cypress has given you advance written
authorization to use the product as a Critical Component in the specific High-Risk Device and you have signed a separate
indemnification agreement.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-
RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more
complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respec-
tive owners.

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 2



&= CYPRESS

> EMBEDDED IN TOMORROW"

Safety Information 5
1. Introduction 6
1.1 CYW954907AEVALIF EVK CONENES ...ooveiiiiieiiiee e 6

1.2 BOArd DEtailS .....oeeeiiiiiieeee e 8

1.3  WICED Studio Development System OVEIVIEW .........cccceeiiiiiiiiiiiiiiiieee e 10

1.4  WICED Studio Code EXampPIEs .........oooiiiiiiiiiiiiieeee e 11

1.5  Kit COde EXAMPIES ..ot e e e e e e 12

1.6 Getting Started......cooo e s 12

1.7 10T Resources and Technical SUPPOIt ........ooiiiiie e 13

1.8 Additional Learning RESOUICES ........c.coiiiiiiiiiiiiiiii e 13

1.9 Document CONVENTIONS ........eiiiiiiiiiiiie ettt e eas 13

L L e (o] 0} 3T P PRSPPI 14

2. Software Installation 15
2.1 Before YOU BeGIN.......ooiiiiiiiiiii ittt 15

2.2 INStall SOMIWAIE ...t e s e e 15

3. Kit Operation 18
3.1 Theory of OPeration .........c..uuiiiiiiiiei et e e e e e e e e e raeeeeaeas 18

3.2  On-board Programmer/Debugger and Serial Interface Chip ..............cccccvvviiieeennnnn. 18

3.3 CYWO954907AEVALTF Kit CONNECHON ....c.viiiiiiiiiiiiieiee e 19

3.3.1  Verifying Driver Installation.............ccoieiiii e 19

SCTRC T2 I (o 18] o] =1 o To) T RS 20

3.3.3  EXternal POWeEr SUPPIY - ..ot 20

3.4  Building, Programming, and Debugging ..........ccocuuiiiiiiiiiiiieieiieee e 21

3.4.1 Building and Programming a Project in WICED Studio IDE........................... 21

3.4.2  TroubleShOOtiNg.......cooiiiiiiii e 24

3.4.3 Debugging a Project Using Breakpoints ...........ccccceeeiviciiiiiiinieee e 24

4. Hardware 28
4.1 Bootstrap and Control PiNS.......cccooii oot e e 28
CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 3



A
W

-

CYPR ES S Contents
4.2 USEr SWITCRES ... e e e 33
A3 LED oo e e e e e e e aa e e e e e aaraaaan 34
44 RESEECONIIO ...t e et e e e e e e e e e e e e aaaeeenaaannn 34
T = 1 1= 4 o= SRR 35
4.6  Micro SD ConnECtOI/SIOt ... ..ot a e 37
S A B X € T 0o o 1= (o PR 37

4.7.1 On-board Programmer/Debugger and Serial Interface Chip..........cccccoecuveeee.. 37

4.7.2 EXIErNAl JTAG ...ttt e e e e e e e e e e e e s ereaaaens 38

T T O] o 1= Tor (o] PP ERERURR 39
4.8.1 WICED HEAET ...ttt ettt e e e e e e e ennnee s 39

4.8.2 Arduino-Compatible Headers............ooouiiiiiiiiiiiiie e 40

4.9 UART Port Configuration on CYW954907AEVALTF Kit.......oeoviiiiiiiiiiieee, 42
4,10 EXIErNAI ADC ... ... et e e e e e e e e arreaaaaaeeenaaannn 42
A AT PWM oottt e e e e e e e e e e e et e e e e e et e e e e e aaraaaas 43
5. Code Examples 45
5.1 USIiNg COAE EXAMPIES ......ovriiiiiiiiiee ettt e e e e e e e e e reeeeeeaaeas 45
ST € 1 [ PR 45
5.2.1 Project DesCrPON ........ueiiiiiiiiee e 45

5.2.2 Hardware CONNECLIONS.........c.uuiiieiiiiie et 45

5.2.3  Verify OULPUL ..ot e e e e e e e e 46

TR B O7o) o) o T (o 11 0 T o] [T [P PP PPPPTPTPPRPN 46
5.3.1  Project DesCriPtiON ......cccoo i 46

5.3.2 Hardware CONNECLIONS........cooiiiiii i e e e 46

B5.3.3  FIOWChAIT. ... .o e a e 47

5.3.4  Verify OUIPUL ... 47

Lo B T O 4T TS U SO 51
5.4.1 Project DesCriPliON ......ccooiiii e 51

5.4.2 Hardware CONNECLIONS........coiiiiiiiii i e e e e e 52

B5.4.3  FIOWChAIT. ... .o e et e e et e e 52

5.4.4 Access Point Credentials ....... ..o 53

5.4.5 Verify OUIPUL ...ooiiiiiie e e e e e e e e e e e e 53

5.5 Publish_SUDSCHDE QWS .......ccooiiiiiiieee e e e e e e e e e e e ae e 54
5.5.1 Project DesCrPON ........uuiiiiiiieiee e 54

5.5.2 Hardware CONNECHIONS.........c.uuiiiiiiiiiii et e 55

5.5.3 FIOWChAI . .. .. e e e e 55

5.5.4  Verify OUIPUL ...ooiiiiiii et e e e e e e e e e e 56
Revision History 65

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 4



Safety Information

&= CYPRESS

> EMBEDDED IN TOMORROW"

The CYW954907AEVAL1F EVK is intended for use as a development platform for hardware or soft-
ware in a laboratory environment. The board is an open-system design, which does not include a
shielded enclosure. Due to this reason, the board may cause interference with other electrical or
electronic devices in close proximity. In a domestic environment, this product may cause radio inter-
ference. In such cases, take adequate preventive measures. Also, do not use this board near any
medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures must be taken.

‘% \ energy discharges. Proper ESD precautions are recommended to avoid performance

The CYW954907AEVAL1F contains electrostatic discharge (ESD)-sensitive devices.
‘ Electrostatic charges readily accumulate on the human body and any equipment, and can
discharge without detection. Permanent damage may occur on devices subjected to high-

degradation or loss of functionality. Store unused kits in the protective shipping package.

E End-of-Life/Product Recycling
This kit has an end-of-life cycle of five years from the year of manufacturing mentioned
|

on the back of the box. Contact your nearest recycler for discarding the kit.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform
procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD
protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal

surface) on the board when handling parts.

Handling Boards

CYW954907AEVAL1F boards are sensitive to ESD. Hold the board only by its edges. After remov-
ing the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if
available. Do not slide the board over any surface. Any physical action on the kit such as changing
wires, jumper settings, or measuring voltages can cause stress on the kit printed circuit board
assembly (PCBA). You must ensure that the PCBA has proper support on the bottom side to avoid
stress on the PCBA when the EVK is in operation.

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 5
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Thank you for your interest in the CYW954907AEVAL1F Evaluation Kit (EVK). The EVK enables
customers to evaluate and develop single-chip Wi-Fi applications using CYW54907 devices.

The EVK uses WICED Studio 6.0 (or later) to develop and debug your CYW54907 project. It offers
footprint-compatibility with Arduino shields. In addition, the kit features an RJ-45 Ethernet connector,
and an onboard programmer/debugger and serial bridge chip. The EVK supports only 3.3 V as the
operating voltage.

WICED Studio 6.0 (or later) supports application development using a WICED development board
(CYW954907AEVAL1F). The development system is compatible with Windows, macOS, and Linux.
This document provides instructions for utilizing peripherals, such as 12C or SPI, in WICED sample
applications using the WICED Studio IDE.

Note: This document applies to WICED Studio 6.0 (or later).

The CYW954907AEVAL1F EVK is available through the Cypress Online Store or through our
distributors.

1.1 CYW954907AEVAL1F EVK Contents

The CYW954907AEVAL1F EVK includes the following:
m One CYW954907AEVAL1F Evaluation Board with assembled Arduino headers
m One USB 2.0 Type-A to Micro-B cable

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 6
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Figure 1-1. CYW954907AEVAL1F Kit Contents

SOTAEVALLF, EWALLSTION KIT QIACH S TART GLIDE

CYW954507AEVALIF EVALUATION KIT

Inspect the contents of the kit. If you find any part missing, contact your nearest Cypress sales office
for assistance: www.cypress.com/support.

Hardware Not Included with the Kit

The EVK does not come with all the hardware needed to perform the demonstrations documented in
this guide.

The following hardware is not included with this kit:

RJ-45 Ethernet cable

External power supply

Dual external antenna

Potentiometer

Jumper Wires

SD card

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 7
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1.2 Board Details

The board consists of the blocks shown in Figure 1-2 and Figure 1-3.
Reset Switch (SW2)

RJ45 Connector (J14)

Micro USB (Programming and Debugging) (J5)
5-12V Power Input (J8)

WICED Header (J6)

Arduino Header (J13)

User Switch 1 (SW3)

User Switch 2 (SW1)

Arduino Header (J9)

0. PCB Antenna-Main (ANT1)

11. Connector for External Antenna 1 (J1)

12. CYW54907 Type 1PS Module (Murata) (U14)
13. PCB Antenna-Diversity (ANTO)

14. Connector for External Antenna 0 (J2)

15. On-board /External JTAG Switch (SW4)

16. External JTAG Header (J3)

17. Arduino Header (J10)

18. Arduino Header (J12)

19. External PHY chip (U12) - BCM5241

20. External ADC Chip (U3)

21. Micro SD Connector/slot (J7)

Figure 1-2. CYW954907AEVAL1F Evaluation Board
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Figure 1-3. CYW954907AEVAL1F Evaluation Board (Back View)
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1.3 WICED Studio Development System Overview

WICED Studio 6.0 (or later) supports application development using the WICED Evaluation Board
(CYW954907AEVAL1F EVK). Tabs and their location in the WICED IDE are as shown in Figure 1-4.

Figure 1-4 illustrates the following:

1. Edit your application firmware.

Help Window that contains instructions on building and downloading applications.
Explore existing applications/firmware and library of the Software Development Kit (SDK).
View Build messages in the Console window.

Create and edit Make Targets for the platform to build your Application/Project.

Figure 1-4. WICED IDE

Al

SR L B Erh e e ar RO E e

k]

v@fp Studio™ Development System
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1.4 WICED Studio Code Examples

WICED Studio includes libraries and code examples supporting both Bluetooth and Wi-Fi platforms.
Selecting the 43xxx_Wi-Fi Filter will show only Wi-Fi platform related files in the project explorer as
shown in Figure 1-5.

Application examples can speed up the design process by serving as templates for development.
Code examples are located under the apps category (in the Project explorer window), as shown in
Figure 1-6. Code examples under apps are further grouped into demo, snip, test, waf (WICED
Application Framework), and wwd (WICED Wi-Fi Driver Application) directories.

The demo directory contains applications that combine various WICED features into a single
application. The snip directory contains application snippets that demonstrate how to use various
WICED libraries and API functions. The test directory contains applications that are used for simple
test and utility. The waf directory contains applications that are part of WICED Application
framework, for instance, the bootloader. The wwd directory contains applications that are developed
using the low level wwd API calls and do not rely on higher level WICED APIs. Located within each
subdirectory in the apps folder is a README.txt that lists and summarizes the applications located
within the folder. It should also be noted that not all applications are supported in all platforms. The
snip directory contains a README.txt with a matrix on what applications are supported in what
platforms. For more details on the WICED software stack and APls, review the Application notes and
documents available in the doc folder <WICED SDK installation folder>/WICED-Studio-6.0/
43xxx_Wi-Fi/doc. WICED-QSG204 available in the same path is a good document to start with.

Figure 1-5. Filter for Wi-Fi Code Example in WICED Studio

e C/C++ - 4300 Wi-Fi/README bet - Eclipse
File Edit Source Refactor MNavigate Search Project Run  WICED Platform  Window Help

o e RS e, COUTEEEE St o i e e

Iy Project Explorer £ = I = [El README.tet E2 |
b (5 4300 WiFi 1 A
= apps 2 Cypress WICED Software Development Kit 6.8 - README
= build =
(= doc S The WICED SDK provides a full compliment of application level APIs,
2 include & libraries and tools needed to design & implement secure embedded wireless
(& libraries 7 networking applications.

(= platforms - A
9Major features of the WICED SDK include ...

(= resources . . - . - N . N .
= - Low-footprint embedded Wi-Fi Driver with Client (STA), softaP and Wi-Fi Direct

& tocks - Wi-Fi <> Bluetooth Internet Gateway

(&= WICED - Various RTOS/TCP stack options including

x| .cproject - ThreadX/NetX (IPv4), ThreadX/NetX Duoc (IPvE)
2 bt - FreeRTOS/LwIP

= gdbinit_zttach - Support for various Cypress Wi-Fi & combo chips

.gdbinit_platform

project

[E API_updates.txt

[ CHANGELDG.bt

[5] generated_mac_address.txt

- 4398X (43909, 43907 and 43983) integrated MCU + Wi-Fi SoC
- 4336X (43362, 43364) Wi-Fi SoC

- 4343X (43438, 4343W) Wi-Fi SoC

- 43348 Wi-Fi + Bluetooth combo SoC

- Support for warious MCU host platforms
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- Atmel : AT91SAMASIGB

= i
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|5 make - Migrated BESL to use Apache-licensed mbedTLS (v2.4.0) cipher suites and cryptographic algorithms

T make.exe - BESL inherits the advantages of mbedTLS such as fully featured TLS extensions and standards compliant SSL library
% Makefile - BESL API remains unchanged resulting in seamless integration with existing TCP/IP and UDP based protocols

: README bt - RTO5 & Metwork abstraction layer with a simple API for UDP, TCP, HTTP, HTTPS communications

- SS5L/TLS Security Library integrated with an HTTPS library for secure web transactions

- DTLS security library integrated with CoAP library

- IoT protocols - HTTP/HTTPS, CoAP, AMQP v1.@ and MQTT

- WICED Application Framework including Bootloader, OTA Upgrade and Factory Reset

- Second flavor of OTA and Factory Reset (called OTA2) X

[E version.tt
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Figure 1-6. Code Examples under apps Category
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2 Cypress WICED Software Development Kit 6.8 - README

5 The WICED SOK provides a full compliment of application level APIs,
6 libraries and tools needed to design & implement secure embedded wireless
7 netwerking applicaticns.

Major features of the WICED SDK include ...

Low-footprint embedded Wi-Fi Driver with Client (5TA), softAP and Wi-Fi Direct

- Wi-Fi «<-> Bluetooth Internst Gateway

- Various RTOS/TCP stack optiens including

- ThreadX/NetX (IPv4), ThreadX/NetX Duo (IPve)
- FreeRTOS/LwIP

- Support for various Cypress Wi-Fi & combo chips

- 4390X (43909, 43987 and 43903) integrated MCU + Wi-Fi SoC
- 4336X (43362, 43364) Wi-Fi SoC

- 4343X (43438, 4343W) Wi-Fi SoC

- 43348 Wi-Fi + Bluetooth combo SoC

- Support for various MCU host platforms

- ST Microelectronics :
- Atmel : AT915AMAS16B
- NXP : LPC17xx, LPC18xx

STM32F2xc, STM32Fdoc

- Migrated BESL to use Apache-licensed mbedTLS (v2.4.8) cipher suites and cryptographic algorithms

- BESL inherits the advantages of mbedTLS such as fully featured TLS extensions and standards compliant SSL library
- BESL API remains unchanged resulting in seamless integration with existing TCP/IP and UDP based protocols

v e

=18

27 - RTOS & Network abstraction layer with a simple API for UDP, TCP, HTTP, HTTPS communications

28 - SSL/TLS Security Library integrated with an HTTPS library for secure web transactions

29 - DTLS security library integrated with CoAP library

38 - IoT protocels - HTTP/HTTPS, CoAP, AMQP v1.8 and MQTT

31 - WICED Application Framework including Bootloader, OTA Upgrade and Factory Reset

3z - Second flavor of OTA and Factorv Reset (called OTA2) *
B Console 53 & ¢8| B B &% MBIy =0

COT Build Console [43ma Wi-Fi]

1.5

1.6

Kit Code Examples

In addition to the examples available in WICED Studio, this EVK includes a few additional code
examples, which can be used to quickly evaluate CYW54907 using this kit. These examples are
described in the Code Examples chapter.

Getting Started

To learn quickly about CYW954907AEVAL1F EVK, refer to the CYW954907AEVAL1F Quick Start
Guide inside the kit box.
This user guide will help you get acquainted with CYW954907AEVAL1F EVK:

m The Software Installation chapter describes the installation of the kit software. This includes
extracting the required files for WICED Studio 6.0 (or later).

m The Kit Operation chapter describes the major sections of the kit such as the on-board program-
mer/debugger chip, reset control, headers, programming and debugging of the kit, and Ethernet

interface.

m The Hardware chapter describes the CYW954907AEVAL1F EVK hardware and its different

blocks.

m The Code Examples chapter describes code examples that will help you understand how to get
started with WLAN basic examples.

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A
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1.7 loT Resources and Technical Support

Cypress provides a wealth of data at www.cypress.com/internet-things-iot to help you to select the
right IoT device for your design, and quickly and effectively integrate the device into your design.
Cypress provides customer access to a wide range of information, including technical
documentation, schematic diagrams, product bill of materials, PCB layout information, and software
updates. Customers can acquire technical documentation and software from the Cypress Support
Community website (https://community.cypress.com). For assistance, go to: www.cypress.com/
support.

1.8 Additional Learning Resources

Visit CYW954907AEVAL1F EVK and CYW54907 for additional learning resources including
datasheets and application notes.

1.9 Document Conventions

Table 1-1. Document Conventions for Guides

Convention Usage
) Displays file locations, user entered text, and source code:
Courier New .
C:\ ...cd\icc\
Italics Displays file names and reference documentation.
Bold Displays keyboard commands in procedures:
o
Enter or Ctrl+C
) Represents menu paths:
File > Open . .
File > Open > New Project
Bold Displays commands, menu paths and icon names in procedures:
o

Click the File icon and then click Open.

Displays an equation:
2+2=4
Text in gray boxes Describes Cautions or unique functionality of the product.

Times New Roman

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A 13
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1.10 Acronyms
Table 1-2. List of Acronyms used in this Document
Acronym Definition
SPI Serial Peripheral Interface
EVK Evaluation Kit
SDK Software Development Kit
WICED Wireless Internet Connectivity for Embedded Devices
JTAG Joint Test Action Group
12C Inter-Integrated Circuit
MQTT Message Queue Telemetry Transport
POR Power-on-Reset
PMU Power Management Unit
VTRIM Voltage Trimming
LPO Low Power Oscillator
GPIO General Purpose Input Output
UART Universal Asynchronous Receiver/Transmitter
AWS Amazon Web Services
IDE Integrated Development Environment
WLAN Wireless Local Area Network
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This chapter describes the steps to install the software tools and packages on a PC for using the
CYW954907AEVAL1F EVK. This includes the WICED IDE in which the projects will be built and
used for programming.

21 Before You Begin

All Cypress software installations require administrator privileges. Ensure that you have the required
privileges on the system for successful installation. Before you install the kit software, close any
other Cypress software that is currently running. Ensure you have installed WICED Studio 6.0 (or
later).

2.2 Install Software

Follow these steps to install the CYW954907AEVAL1F Evaluation Kit software:

1. Download and install WICED Studio 6.0 (or later) from this web page. The following is a
screenshot of the Installer Window when opened.

£ WICED-Studio Led =

Introduction

@ Introduction InstallAnywhere will guide you through the installation of

() Choose IDE Install Folder WICED-Studia.

(O Choose SDK Install Folder Itis strongly recommended that you quit all programs before
O Pre-Installation Summary continuing with this installation.

() Installing....

(D) Driver Install

() Install Complete

Click the 'Mext' button to proceed to the next screen. If you want to
change something on a previous screen, click the 'Previous' button.

You may cancel this installation at any time by clicking the 'Cancel
button.

by CYPRESS"

{CED
&

InstallAnywhere

Cancel Previous

2. Select two folders, one for the IDE and the other for the SDK. The folder for the SDK contains the
framework for developing Wi-Fi applications.

3. As alast step in installation, installer will ask to select between Wi-Fi and Bluetooth platform.
Select 43xxx_Wi-Fi as default.
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4.

5.

6.

Software Installation

Download the CY954907AEVAL1F_KitPackage.zip software from here. The software is
available as a zip file.

Locate the WICED Wi-Fi-SDK directory in your PC. The default location is C:\Users\<user
name=>\Documents\WICED-Studio-6.0\43xxx_Wi-Fi, as shown in Figure 2-1. However, it may be
in a different location depending on the path you choose when installing WICED Studio.

USB to serial UART with a 3.3V TTL Adapter cable allows to connect between the host or
computer and CYW89072EVAL. This connection refers as a regular serial communication

Figure 2-1. WICED SDK Directory

B[] = | 4300 Wik = B %
Home Share View 9
- 1\ » |This PC » Documents > WICED-Studio-6.0 » 43mo Wi-Fi | v & | Search4i. @
»~
Marme Date modified Type Size A
# Quick access
apps
& OneDrive - Cypress Ser build
v [ This PC e
include
B Desktop sl
- libraries
» |5 Documents it
& Downloads resources
J\ Music tools
= Pictures WICED
B videos | «cproject
|| .gdbinit

= Local Disk (C:) o
| .gdbinit_attach
¥ Metwork | .gdbinit_platform
| | .project
\=| API_updates.bd
= CHANGELOG.bdt
=| generated_mac_address.bat
= LICEMSE.txt
|| make
[ make.exe +
=, >

24 items

Copy the CY954907AEVAL1F_KitPackage.zip file and extract to a temporary location such as
"temp". The zip file will extract two directories called "apps" and "resources" inside the temp/
CYW954907AEVAL 1F_KitPackage/ directory. Select both of them, Copy (Ctrl+C) and paste
(Ctrl+V) into C:\Users\<user name>\Documents\WICED-Studio-6.0\43xxx_Wi-Fi. Choose the
option to merge with existing folders.

Alternately, copy the CY954907AEVAL1F_KitPackage.zip to the location specified above and
use the Extract Here option if you have 7-Zip or another unzip utility. The zip file should be
merged to the existing folders. If WICED Studio 6.0 (or later) is opened with 43xxx_Wi-Fi as the
WICED Filter (Figure 1-5), then the new folders appear as shown in Figure 2-2.
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Software Installation

Figure 2-2. Setup Package in WICED Studio 6.0 (or later)

e CiC++ 58
File Edit Source Refacter Mavigate Search
e L e g
By Project Biplorer 52 | B 58| & ¥ O
v (5 4300 Wi-Fi A
v (= apps
= demo
v = kit
VWOS4B0TAEVALTF

v B C

. adc_measure
(= config_join_ping
(= publish_subscribe_aws

= snip
(= test
(= waf
A
[E] READMEtt
build
doc
= include
libraries
platforms
resources
~ = apps
v [ adc_measure
@ data.html
@ main.html
= amgps
= appliance
= apsta
= avs
(= aws_iot
(= azure_jot_hub
(= duktape
» (= flac

1ap onsoles to dheplay S i fime,

R

Eldlcidt - Ry R

[E] README bt 51

Cypress WICED Software Development Kit 6.8 - README

The WICED SOK provides a full compliment of application level APTs,
ibraries and tools needed to design & implement secure embedded wireless
networking applications.

9 Major features of the WICED SDK include ...
1e Low-footprint embedded Wi-Fi Driver with Client (STA), softAP and Wi-Fi Direct
Wi-Fi <-> Bluetooth Internet Gateway

Various RTOS/TCP stack options including

- ThreadX/HetX (IPv4), ThreadX/NetX Duoc (IPvS)

- FreeRTOS/LWIP

Support for various Cypress Wi-Fi & combo chips

- 4398X (43909, 43967 and 43983) integrated MCU + Wi-Fi SoC

- 4336X (43362, 43364) Wi-Fi SoC

- A4343X (43438, 4343W) Wi-Fi SeC

- 43348 Wi-Fi + Bluetooth combo SoC

Support for various MCU host platforms

- ST Microelectronics : STM32F2xx, STM32F4wx

- Atmel : ATO1SAMASLEB

- NXP : LPC17xx, LPCI8xx

Migrated BESL to use Apache-licensed mbedTLS (v2.4.8) cipher suites and cryptographic algorithms
- BESL inherits the advantages of mbedTLS such as fully featured TLS extensions and standards compliant 550 library
- BESL API remains unchanged resulting in seamless integration with existing TCP/IP and UDP based protocols
RTOS & Network abstraction layer with a simple API for UDP, TCP, HTTP, HTTPS communications
SSL/TLS Security Library integrated with an HTTPS library for secure web transactions

DTLS security library integrated with CoAP library

IoT protocels - HTTP/HTTPS, CoAP, AMQP v1.@ and MQTT
WICED Application Framework including Bootloader, OTA Upgrade and Factory Reset

- Second flavor of OTA and Factory Reset (called OTA2)

B Console 52

7. The CY954907AEVAL1F_KitPackage.zip package contains three code examples which add to
the existing set of examples available in WICED Studio 6.0 or later. Unzipping creates the kits
directory under apps, and adc_measure in the resources\apps directory.

After unzipping, if the projects are not visible in WICED Studio 6.0 (or later), then right-click the
top most folder (43xxx_Wi-Fi) and click Refresh, as shown in Figure 2-3.

Figure 2-3. Refresh Top Folder

= C/C++ - 4300 Wi-Fi/README.bt - Eclipse
File Edit Source Refactor Navigate Search Project Run  WICED Platform Window Help
R |- R~ im0 D] B Ao wicFi & SRR ERAcEE R R A R0 e S S
[t Project Explorer 52 |55 & & = © | 2 READMEN 32 =
v (5 4300 "
v Ea e > Software Development Kit 6.8 - README
& Go Into
v @ Copy. Ctd+C  provides a full compliment of application level APIs,
A tools needed to design & implement secure embedded wireless
Paste Q¥ Bications.
# Delete Delete
R nore e Conteas i AR SH D of the WICED SDK include ...
) Nemgie o Colial CtisAltsShiftsDown  § 0t embedded Wi-Fi Driver with Client (5TA), softAP and Wi-Fi Direct
- Move luetooth Internet Gateway
& R F2 S5/TCP stack options including
z e NetX (IPv4), ThreadX/NetX Duo (IPvG)
Impert... LNIF‘ — -
F various Cypress Wi-Fi & combo chips
Export... 999, 43907 and 43983) integrated MCU + Wi-Fi SoC
362, 43364) Wi-Fi SoC
Refresh E5 438, 4343W) Wi-Fi SoC
Close Project Fi + Bluetooth combo SoC
F various MCU host platforms
Close Unrelated Projects Blectronics : STM32F2xx, STM32Fdxx
= AT915AMAS16E
Build Cenfigurations > B17300, LPC18xx
Make Targets > ESL to use Apache-licensed mbedTLS (v2.4.8) cipher suites and cryptographic algorithms
erits the advantages of mbedTLS such as fully featured TLS extensions and standards compliant SS5L library
st > | remains unchanged resulting in seamless integration with existing TCP/IP and UDP based protocols
atiat work abstraction layer with a simple API for UDP, TCP, HTTP, HTTPS communications
alicate curity Library integrated with an HTTPS library for secure web transactions
Show in Remaote Systems view ity library integrated with CoAP library
et Tadks , Pls - HTTP/HTTPS, CoAP, AMQP v1.@ and MQTT
1 Jisdent Al ication Framework including Bootloader, OTA Upgrade and Factory Reset
B2 Profile As » lavor of OTA and Factory Reset (called OTA2) %
B Debug As >
ER Run As > 1 s @-pr= 0
Eh )
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This chapter introduces you to the CYW954907AEVAL1F EVK and the features that will be used as
part of the kit operation. Features such as Wi-Fi connection and programming/debugging are
discussed in this chapter. The chapter also describes the USB-UART that can be used to
communicate with the CYW54907 device on this EVK.

3.1 Theory of Operation

Figure 3-1 illustrates the block diagram of the CYW954907AEVAL1F EVK. This board contains
CYW54907-based SiP, which is a Type 1PS Wireless module. This module is an embedded network
controller solution from Murata. This board also contains a USB-Serial interface / JTAG programmer
/ debugger. This board features Arduino form-factor-compatible headers, which enables Arduino
shields to be plugged on top, extending its capabilities. This board also features two user switches,
two user LEDs, an RJ-45 connector for Ethernet, and a reset switch for the wireless module.

Figure 3-1. Block Diagram of CYW954907AEVAL1F EVK
CYWS54907AEVALLF

IZ/I
N

1 Omorezz 1 Oroam
— sW é '.;l_;““ CYW54907-based SIP

3.2 On-board Programmer/Debugger and Serial Interface Chip

An FT-2232-HQ chip is used for onboard programming, debugging and USB-Serial functionality. It
connects to the computer over a USB interface and connects to the CYW54907-based SiP module
over JTAG and UART pins. Alternatively, you can use the External JTAG connector (J3) along with
switch SW4 (in all closed positions) to use JTAG from connectors such as Olimex.
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3.3 CYW954907AEVAL1F Kit Connection

The CYW954907AEVAL1F EVK can be powered by the following options: External power supply
and USB.

When using an external power supply, use a 5 V - 12 V, 2A power supply with 2.1-mm DC Jack
(center pin positive). When powered from USB, there are two logical USB devices: a USB-JTAG
device and a USB-UART device. Drivers for the CYW954907AEVAL1F EVK are automatically
installed during the WICED SDK installation process. When you connect the kit for first time to your
PC, it will initiate the driver search as shown in Figure 3-2.

Figure 3-2. Driver Software Installation
| Driver Software Installation L&J

Your device is ready to use

USB Composite Device o Readyto use
WICED USE JTAG Port o Readyto use
WICED USE Serial Port B o Ready to use
WICED USB Serial Port (COM53) o Readyto use

| Close |

3.3.1 Verifying Driver Installation

Do the following to verify the successful completion of driver installation:
1. Right-click My Computer > Properties.
2. In the System Properties window, select Device Manager.
a. The WICED USB Serial Port is listed under Ports (COM & LPT) as shown in Figure 3-3.

b. The WICED USB JTAG Port is listed under WICED USB JTAG Devices as shown in
Figure 3-3.
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The Device Manager window identifies the WICED USB Serial COM port as COMXX. The assigned
port number varies between systems. If the device displays two WICED USB Serial Ports (WICED
USB Serial port and WICED USB JTAG Port) instead of one, then follow the link mentioned in this
post.

Figure 3-3. Verifying Device Driver Installation

% Device Manager - O *
File Action View Help
o= @ E HR =

v @ INDCLAPPCOASUNK
> B Audioinputs and outputs
> @ Batteries
| Biometric devices
g Bluetooth
» B3 Computer
5w Disk drives
[5& Display adapters
=m IDE ATA/ATAP| controllers
> _‘i‘;‘ Imaging devices

> 2 Keyboards
LI Memory technology devices
@ Mice and other pointing devices
> [ Monitors
> @ Metwork adapters
v i Ports (COM & LPT)
E WICED USE Serial Port (COM4)
» [ Print queues
3 D Processors
B Security devices
B Software devices
» B Sound, video and game controllers
> QT‘ Storage controllers
¥ System devices
i Universal Serial Bus controllers
v ' WICED USE JTAG Devices
i WICED USE ITAG Port

3.3.2 Troubleshooting

If an error occurred during the automatic driver installation process, the driver may be manually
installed from the following directory: <WICED-SDK>\Drivers\Windows\wiced_uart.

If the CYW954907AEVAL1F EVK does not appear in the Device Manager, verify that the +3V3 LED
is turned ON and check the USB cable.

3.3.3 External Power Supply

The CYW954907AEVAL1F EVK can be supplied using an external power supply (5V-12V, 2A), using
a 2.5 mm DC Jack with center pin positive. When using an external power supply and also
connecting a USB cable (for programming/debugging or USB-UART), the voltage on the external
power supply should be greater than that of the USB supply; if not, the kit will be actually sourcing its
power from USB rather than the external power supply.
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Building, Programming, and Debugging

Building and Programming a Project in WICED Studio IDE

Do the following to build and program a project for CYW954907AEVAL1F EVK:
1.

oo e e i e o e

Open the WICED IDE on Windows PC: go to Start > All Programs > Cypress > WICED-
Studio.

Select 43xxx_Wi-Fi in the WICED Target selector drop-down box as shown in Figure 3-4.
Building a project requires a corresponding make target, located in the Make Target window. All
applications should go under the apps directory. The make target path will contain the directory
hierarchy starting from apps with directory names separated by a period. The project name is
followed by a hyphen and then the platform name. Finally, the actions to be performed after the
build are specified such as download and run. For example, to build, download, and run the
application scan which exists in apps\snip\scan, create the following make target:
snip.scan-CYW954907AEVALLF download run

This project will periodically scan for Wi-Fi access points and will list them using the serial to
USB connection on the kit.

Note: By default, the kit comes pre-programmed with the same snip.scan example.

Do the following to create the make target, build, program, and test application scan:
Right-click 43xxx_Wi-Fi in the Make Target window as shown in Figure 3-4, and click New.

Figure 3-4. Creating New Make Target

mi) - Cluick Access {._“g'i %C}C++ '%}Debug
E READMEDt 32 s = B | @ Make Target 52 @ @& | H o oiEs 8
P VR = e A
& & New.
: Edit... F2 badrun
@) e wenload run
@ T WO43G07AEVALTF download rur
@® Ga Back CYWG43907AEVALTF download
@ = Golnto £_aws-CYWS43907AEVALTF dow
(@) = ~ hun
= Copy Ctrl+C i
@ L oad run
@ [ Paste Ctri+
(@) Delete Delete oad
——————— T T ST @
| | | | @ Build Target 1
| | coe | | | = Rebuild Last Target F9  p.SDIO download
TLS | DNS | ping SMTP SHNTP - ownload run
_______ L s e i e R i (@) snip.scan-BCMBS43362WCD4-5Pl downlead run
| | x (&) snip.scan-BCMB43362WCD4-ThreadX-NetX_Due-5DM0 downlead run
"""" o TR e e & (@) snip.scan-BCMB43362WCD4-ThreadX-MNetX-SP| download run
_______ J|r_____J|r_______ N & snip.scan-CYWI43007AEVAL 1F-debug v
. < z
------- A N, T, S—— = o 5 s
X b X | X X fDHelp 2 B J| ¢ g m
'";(‘"Jlf";("*l' """"""""""" 2 Contents &7 Search BE Related Topics [l Bockmarks [ Index
——————— e e el Cypress WICED Studio IDE Documentation >
| &
_______ LB SRS R (SR
| | ) 5 2
——————— e e S {CED Studio™ Development
T Y CVPAESS
_______ T R e L\
| |
....... o [nsa e || SYSTEM
>
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4. Enter snip.scan-CYW954907AEVALLF download run in the Target name field and click
OK.

Note: The list of all commands that can be provided in the Make target is listed in <WICED-SDK
installation directory>/ 43xxx_Wi-Fi/Makefile.

snip.scan-CYW954907AEVALLF download run indicates the following:
snip = directory inside apps folder

scan = Sub-directory and name of the application to be built. For example, to build the console
application under test directory in apps, then use test.console instead of snip.scan.

CYW954907AEVAL1F = Board/platform name
download = Indicates download to target

run = Resets the target and starts execution

5. Double-click (alternately, right-click and select Build Target) the Clean Make Target to remove
any output from the previous build. You should do a Make clean when any new files are added or
removed to the corresponding target.

Note: Ensure that you have connected CYW954907AEVAL1F EVK to the same PC via USB
prior to executing the build target.

6. Double-click (alternatively right-click and select Build Target) the snip.scan-
CYW954907AEVAL1F download run make target to build and download it to the
CYW954907AEVAL1F EVK.

The project is built and programmed into the CYW954907AEVAL1F EVK, as shown in

Figure 3-5.
Figure 3-5. Successful Build and Program

Bl Console 57 [® Problems -4° Search %% Debug L 4 Bl LB &B x| BN = 0
CDT Build Console [43w00¢ Wi-Fil
Creating Filesystem BCM343%@x_targets.mk ... P~
Downloading DCT ... build/snip.scan-CYWIS4907AEVALIF/DCT.bin @ SFLASH DCT_LOC=-0x@0803008
./ tools/common/Win32/mk_wicedfs32 build/snip.scan-CYWI54907AEVALLF/filesystem.bin build/snip.scan-CYW954987AEVALLF
Creating Filesystem Done

Building apps lockup table
Downloading Bootloader ...
Finished Downloading Bootloader

Downloading resources filesystem ... build/snip.scan-CYWIS4987AEVALIF/filesystem,.bin at sector 17 size 125...
Downloading APP@® build/snip.scan-CYWS549@7AEVALLF/binary/snip.scan-CYWIS4987AEVALLF . stripped.elf @ sector 142 addr
Downloading apps lookup table in wiced apps.mk ... build/snip.scan-CYWIS4387AEVALIF/APPS.bin {§ 8x08012000 size

Resetting target
Target running
Build complete
Making .gdbinit

12:10:86 Build Finished (tock 3m:30s.56ms)

< >

7. To view output messages with a terminal emulation program (such as Tera Term), follow these
steps:

a. Start the terminal emulation program.
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Kit Operation

b. You will see the following window. Click on Serial and select corresponding COM Port for your
WICED device. Then click on OK

e Edit S -
¢ Edit Sef T Term: New connection

O TCPHIP myhost.example.com

History

Telnet I 22

S5H aal Ex S8H2

Other
UNSPEC

@ Serial Port: | COMA4: WICED USB Serial Port [COM!

Cancel Help

c. Inthe Terminal Emulator, go to Setup > Serial port.... Select the correct COM port and baud
rate as follows.
Note: Exact Port number will vary with the corresponding PC port

Port: COMA w 0K
Baud rate:

Data: 8 bit v Cancel
Parity: none W

Stop: 1 bit v Help
Flow control: none e

Transmit delay
!l]_’—i msecichar E msecfline

d. Press the Reset button (see Figure 1-1) on the CYW954907AEVAL1F EVK to view the
application startup messages.
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8. The output of the Terminal Emulation program should be similar to what is shown in Figure 3-6.

Figure 3-6. Console Output

¥ COMA - Tera Term VT - ] X

File Edit Setup Control Window Help

Starting WICED uvWiced_ ©86.000.000.00843
Platform CYW954987AEVALLF initialised
Started ThreadX v5.6
Initialising Met¥ _Duo w5.7_sp2
Creating Packet pools
: 66:55:44:33:22:27

WLAN Firmuware : wlB: Oct 23 2817 @3:40:42 wersion 7.15.168.181 (r674438) FWID
@1-13cael2
WLAN CLM : APIz 12.2 Data: 9.10.74 Compiler: 1.31.3 Clnlmport: 1.36.3 Cr
eation: 2017-18-23 @3:36:41
Waiting for scan vesults...
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P
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F@:5C:19:8A: UEP CY¥TestNexus

IN PROBE
FB:5C:19:8A: WPA2 PSK CY-MCU

IN PROBE
FA:5C:19: [ﬁ > WPA2 PSK CY-WICED
FB:5C:19:8A: WPA2 Enterprise CYFI

IN e
FB:5C:19:8A: y WEP CYPPHONE
FB:5C:19:8A: 3 WPA2 CY-10T-HOTSPO
F@:5C:19:8A: 3 UEP CY¥TestNexus
FA:5C:19: [ﬁ y WPA2 PSK CY-MCU
FB:5G:19: [ﬁ 3 WPA2 PSK CY-WICED
FB:5C:19:8A: WPA2 Enterprise CYFI

IN P
FB:5C:19:8A: WEP CYPPHONE

IN PROBE
FA:5C:19:8A: Open CYPGUEST

IN PROBE
FB@:5C:19:8A: 5 WPA2 CY-10T-HOTSPO
F@:5C:19:8A: = WEP CYTestNexus
FA:5C:19:8A:8C:D5 -67 458.0 WPA2 CY-MCU

1
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3
4
5
[
?
8
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—
e e e e e e
=N S b W N =@

-
=

3.4.2 Troubleshooting
If a “download_dct” error message is displayed despite connecting the board, follow the steps
outlined in this post.

3.4.3 Debugging a Project Using Breakpoints

After programming a project, it is possible to debug it in CYW954907AEVAL1F EVK using the built-in
debugger.

Note that the scan example used in 3.4.1 Building and Programming a Project in WICED Studio IDE
section is also used here. Steps outlined there should be first followed with a slight change (adding -
debug to the Make Target command and removing run).

Instead of
snip.scan-CYW954907AEVALIF download run
Use the following make command:

snip.scan-CYW954907AEVAL1F-debug download
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If -debug is not added, it will be built for release. The important difference between the debug and
release configurations is the optimization. Debug is built with no optimization and release is built with
optimization. It is possible to debug without using debug as well, but with many variables and lines
optimized away, many breakpoints might not get hit.

Note that breakpoints must be placed after starting a debug session in WICED Studio 5.0 or later. If
there are any breakpoints that were created prior to the start of debug session, their properties must
be changed to be enabled for all threads.

Do the following to debug the project:

1.
2.

Execute the make target described above to download the project to the device.

Click the arrow next to the Debug icon as shown in Figure 3-7 and select 43xxx-Wi-
Fi_Debug Windows. On the Confirm Perspective Switch dialog, click Yes. The debug session
starts and halts in the start GCC.sffile.

Note:

o The Confirm Perspective Switch dialog is not displayed if you have previously selected the
Remember my decision checkbox in the Confirm Perspective Switch dialog.

o If any MakeFile/Build error occurs, then clean (using the Clean make target), rebuild, and
download to the CYW954907AEVAL1F EVK again. The Debug session starts and halts in the
start GCC.sfile.

o In the Debug Perspective, the Project explorer window goes away by default. To view the
source files, switch back to the "C/C++" perspective.

o To switch between perspectives, use the "C/C++" or "Debug" icon at the top right corner of
screen.

Figure 3-7. Debugging Project

I3 Project Explorer 33

= ttp
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[i=- security_types
(= service_discovery
(= sntp_get_time
(= spi_slave
(= ssdp

(== stack_overflow

= stdio

(= tep_client

(= tcp_client_powersave
= tep_server

(= tcp_server_async

= thread_monitor 53 #include <stdlib.h>

(= udp_receive

(=2 udp_transmit

= websocket_client

(- websocket_server

(£ wifi_connection_manager
(2=~ wps_enrollee

(= wps_registrar

[ README txt = -
= test =
(= waf x
& i B Console &2 4 oS Bel % | ®B~-mir=0
[2 README.bxt COT Build Console [43n0 Wi-Fi]

= g CEADMESE iR 5 [©] 14300 Wi-Fi_Debug_Linuxb4 ‘
= = 3 ke e 5

54 #include "wiced.h™

#define DELAY BETWEEN_SCANS ( seee )
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3. Open the scan.c file from the Project Explorer window. Click on the line with
WPRINT_APP_INFO( ( "Waiting for scan results...\n" ) ); and press
CtrI+Shift+B. A blue hollow circle along with a check mark appears next to the line number as
shown in Figure 3-8.

4. From the main menu, click Run > Resume. Execution will stop at the breakpoint that you added.
To continue after hitting the breakpoint, click Resume again.

5. To disable the breakpoint, press Ctrl+Shift+B again on the same line, or deselect the
corresponding checkbox in the Breakpoints window.

Note: If the Breakpoint window does not appear, choose Window > Show View > Breakpoints.

6. To terminate the debugging session, click Run > Terminate, or click on the red square icon.
Once you terminate the session, click on "C/C++" in the upper-right corner to return to the C/C++
perspective.

Figure 3-8. Placing Breakpoint in Code

4= Debug - 4300 Wi-Fi/apps/snip/scan/scan.c - Eclipse
File Edit Source Refactor Mavigate Segrch Project Run WICED Platform Window Help

L= ey | e w [ RN 430 Wi-Fi Vil T ORI E Yl S G =
45 Debug ! il =218 8g Breakpoints ]
v [T] 4300 Wi-Fi_Debug_Windows [GDB Hardware Debugging] [¥] o scan.c[line 109]

v (W last_built.elf
w o Thread #2 5095240 (app thread : : Ready) (Suspended : Breakpoint)

2pplication_start() at scan.c:109 Oxdaddbb
application_thread_main() at wiced_rtos.c:231 (nda0b%4
_tx_thread_shell_entry() at (xdacBbe

IRIIRIE]

§_tx_thread_schedule() at Oxdazaed

(@ Thread 23 5000140 (System Timer Thread : : Suspended) (Suspended : Container)
i Thread #4 4998308 (system monitor: : Waiting - Semaphore) (Suspended : Container)
(¥ Thread #3 4997796 (worker thread : : Waiting - Queue) (Suspended : Container)

¢# Thread #6 4998052 (worker thread : : Waiting - Queue) (Suspended : Container)

{# Thread =7 5004684 (WWOD : : Waiting - Semaphore) (Suspended : Container) No details to display for the current selection.

wi Ci/Users/kavs/Documents/WICED-Studio-5.0/4300_Wi-Fiftools/ARM_GNU/bin/Win32/arm-none-eabi-gdb.exe (7.7,
< >
[€ scan.c 57 | [ (gdbl1].proc[42000] threadGroup(i1] gdb[ 1].proc[42000].OSthread| 1]).thread 1]. frame[0] Lt] platform uart.c

6-void application_start( )

wiced_init( );

while(1)

{
wiced_time t scan_start_time;
wiced_time_t scan_end_time;

app_scan_data_t scan_data;

* Initialize the semaphore that will tell us when
wiced_rtos_init_semaphore(&scan_data.semaphore);

scandata caculs count = @

WPRINT APP INFO “Waiting for scan results..\n" 3
_APP_ ype ate Chan Security SSID\R" ) );
WPRINT_APP_INFO( ("----- s S F e e PR R e e EEEE e e e ey e e s VRIS T

wiced_time get time(&scan_start time);
wiced wifi_scan_networks(scan_result_handler, Bscan_data );
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7. If Breakpoints are created prior to starting the current debug session, they will not be associated
with the current thread and will be indicated with a blue circle without a check mark. To enable
breakpoints in the current thread, associate the properties from the Breakpoints window with the
current thread.

Note: If you do not see any breakpoints in the Breakpoints window, click the Show Breakpoints
Supported by Selected Target icon as shown in Figure 3-9. The breakpoints are displayed.
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8. Right-click the desired breakpoint checkbox and click Breakpoint Properties.... Click the

last_built.elf check box, as shown in Figure 3-10. The check mark appears before the actual
breakpoint indicating its association with the current execution.

Figure 3-9. Show Breakpoints Icon

Fle [ Sewce Befsger Hevgee Sepch Brogn Bus WCED Plforn Window Help
- (R &

=

ko Wi F

= R
o sbeh
W watedh

® DAY BUTAEIN SCa]

Figure 3-10. Enabling Breakpoint for Current Execution
[ = Properties for C/C++ Line Breakpoint - e L s | El ﬂ! o
type filter text Filter goie o TR
Common =
Bt Restrict to Selected Processes and Threads:
Fiter + I It buiket)
[¥] & Thread #1 [] -1 (Current Execution)
]
I
| L
® E OK 1 [ Cancel
L =i
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This chapter describes the CYW954907AEVAL1F EVK hardware and its different blocks, such as
Bootstrap, reset control, Arduino-compatible headers, and module connectors.

The schematic is available at the following location after installing the software from Software
Installation:
<WICED_SDK_Directory>\43xx_Wifi\platforms\CYW954907AEVAL1F\schematics

4.1 Bootstrap and Control Pins

Bootstrap options available in the CYW954907AEVAL1F EVK are shown in Table 4-1. The pins are
sampled at power-on reset (POR) to determine various operating modes. Sampling occurs a few
milliseconds after an internal POR or deassertion of the external POR. After the POR, each pin
assumes the GPIO or alternative function specified in the CYW54907 Alternate GPIO function table
in the CYW54907 datasheet (002-19312).

You must ensure that SPI mode and SDIO Host are not turned on at the same time because they
share the same set of lines. For more information regarding bootstrap options, see the CYW54907
datasheet (002-19312).

Bootstrap options other than GPIO_7 and GPIO_13 are not available to modify in this board.

To change bootstrap options for GPIO_7 and GPIO_13, see the "Bootstraps, Flash" page of the
schematics.

Table 4-1. Bootstrap Options Available in CYW954907AEVAL1F EVK

Strap Pull
Pin Strp Function
Chip default Board Default
gSPI Mode
GPIO_1 0 = Enable gSPI Mode 0 0
1 = Disable gSPI Mode
WCPU Boot Mode: 1
GPIO_7 0 = TCROM Boot 0 R135=10K to
1 = TCMSRAM Boot WLAN_VDDIO
ACPU Boot Mode:
GPIO_11 0 = SOCROM Boot 0 0
1 = SOCSRAM Boot

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A
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Table 4-1. Bootstrap Options Available in CYW954907AEVAL1F EVK (continued)

Strap Pull
Pin Strp Function :
Chip default Board Default
SDIO Mode: 1
GPIO_13 0 = SDIO Device 0 R141=10K to
1 = SDIO Host WLAN_VDDIO
Host DAP Clock Sel
RF_SW_CTRL 5 1 = Enable XTAL clock for DAP sub system 0 0
0 = Disable Use Test clock TCK for DAP sub sys-
tem
PMU resource initialization mode selection
RF_SW_CTRL_7 1 = Mode 1 0 0
0 = Mode 2
LPO( Low Power oscillator) Selection:
RF_SW_CTRL_9 0 = LPO from HIB (Hibernation Block) 0 0
1 = Internal 32KHz LPO

Note: There is no bootstrapping provision for GPIO_1, GPIO_11, GPIO_15, RF_SW_CTRL_5,
RF_SW_CTRL_7, and RF_SW_CTRL_9 on the EVK board.

1. HIB_LPO_SEL and RF_SW_CTRL_9_HIB_LPO_SEL_UART2_TX
HIB_LPO_SEL

By default, this is automatically selected between the external crystal and internal oscillator. If only
an internal oscillator is used, strapping of HIB_LPO_SEL is irrelevant.

Figure 4-1. HIB_LPO_SEL strapping Option

HE_LPO_SEL Ciy i
i R156

&

ATk

RF_SW_CTRL_9 can also be used for LPO Selection. However, it should be pulled LOW to use the
recommended external 32.768-kHz HIB crystal.

0 = LPO from HIB
1 = Internal 32-kHz LPO
Note:

You should use the external 32.768-kHz crystal for a more accurate clock. Accuracy of the clock is
critical when using power save mode. If an internal LPO is used, the board may become
unresponsive at higher temperatures (>80°C).
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2. HIB_REG_ON_IN

Hardware

Used by the Hibernation (HIB) block to power up internal CYW54907 regulators. If the
HIB_REG_ON_IN pin is LOW, regulators are disabled. For the HIB_REG_ON_IN pin to work as
designed, HIB_REG_ON_OUT must be connected to REG_ON.

The CYW54907/BCM54907 datasheet states that HIB_ REG_ON_IN needs to be delayed by at least
two cycles of the 32.768-kHz clock after VBAT and VDDIO have reached 90% of their final values.
To ensure a proper bootup, the RC delay circuit for HIB_REG_ON_IN is essential as shown in the

following figure:

Figure 4-2. HIB_REG_ON_IN Delay Circuit

WLAN_VDDIO

Figure 4-3. An Excerpt from CYW54907 Datasheet (Section 18)

Notes:

B The CYW54907 has an internal POR circuit. The device will be held in reset for a maximum of 110 ms after VDDC and VDDIO

have both passed the POR threshold.

B The 10%-90% Vgar rise time should not be faster than 40 microseconds. Vgar should be up before or at the same time as

VDDIO. VDDIO should not be present first or be held high before Vpar is high.

18.1.2 Control Signal Timing Diagrams

Figure 37. REG_ON = High, No HIB_REG_ON_OUT Connection to REG_ON

32678 kHz | | | | | | | |

Sleep Clock

VBAT

vDDIO

REG_ON

> 2 Sleep Cycles

e S EEEE——

HIB_REG_ON_IN

Figure 38. HIB_REG_ON_IN = High, HIB_REG_ON_OUT Connected to REG_ON

32.678 kHz | | I | | | I |

Sleep Clock

VBAT

VDDIO

HIB_REG_ON_IN

> 2 Sleep Cycles

—p,
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3. HIB_WAKE
Used to wakeup chip from Hibernation mode. This pin should be pulled HIGH.
Figure 4-4. HIB_WAKE Strapping Option

'|.'|r' LAN_VDDIO

A

P Ri54

P 4Tk .

.~ _HIB_WAKE G !

lIee

4. USB2_HOST_DEV_SEL
Used to select the USB mode; it is set in USB DEVICE mode by default.
0 = USB HOST mode
1 = USB DEVICE mode
Figure 4-5. USB2_HOST_DEV_SEL Strapping Option

5. JTAG_SEL and GPIO_8_TAP_SEL States for Test and Debug Function Selection
JTAG_SEL
Set JTAG_SEL:
0 = JTAG interface disabled
1 = JTAG debug mode enabled
GPIO_8 TAP_SEL
Set GPIO_8 (TAP_SEL):
0 = WLAN JTAG
1=APPS JTAG
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Note: Default setup is JTAG_SEL = HIGH / TAP_SEL = HIGH.
Figure 4-6. JTAG_SEL and GPIO_8_TAP_SEL Strapping Option

WLAN_VDDIO WLAN_VDDIO

i R1z | Ri12E

GPIO_B_TAP SEL

[%]
USSR N —
T 1

AL | ™ 58 GRIcs TARSEL g

JTAG _SEL

'||m. N

6. GPIO_1_GSPI_MODE
GPIO_1 is used for gSPI mode. By default, CYW54907 enables gSPI.

0 = gSPI engine enabled
1 = gSPI engine disabled

7. GPIO_7_WCPU_BOOT_MODE
GPIO_7 is used for WCPU Boot mode, and pulled HIGH for reccommended TCMSRAM Boot mode.

0 = TCROM Boot
1= TCMSRAM Boot
Figure 4-7. GPIO_7_WCPU_BOOT_MODE Strapping Option

WLAN_VDDIO
L

R135

GPIO_7_WCPU_BOOT_MODE  {¢{~

8. GPIO_9 USB_SEL

GPIO_9 is used for USB selection. CYW54907 uses USB mode only; therefore, pull this pin HIGH.
0 = HSIC Sel
1=USB PHY

9. GPIO_11_ACPU_Boot Mode

GPIO_11 is used for ACPU Boot mode; by default, CYW54907 sets it to the recommended
SOCROM Boot.

0 = SOCROM Boot
1 = SOCSRAM Boot
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10. GPIO_13_SDIO_MODE
GPIO_13 is used to select the SDIO mode; it is set in SDIO HOST mode by default.

0 = SDIO Device
1 = SDIO Host

Figure 4-8. GPIO_13_SDIO_MODE Strapping Option

GPIO_13_SDIO_MODE ¢4

GPIO_13_SDI0_MODE ¢

WLAN VDDIO

A

B s L

.

11. RF_SW_CTRL_7_RSRC_INIT_MODE_UART1_TX_OUT
This pin should be pulled HIGH.

Highly Recommended to pull up RF_SW_CTRL_7 via a 10K resistor to WLAN_VDDIO during
bootup. Do not leave it floating. If left floating, the first-time programming of the SFlash fails, while
second-time programming passes.

12. CYW54907 in Deep Sleep Mode

To wake up CYW54907 from deep sleep mode, any GPIOs from GPIO_0 to GPIO_15 (except
GPIO_13) can be used. The selected GPIO should not be pin-muxed; instead it should be a
dedicated one for deep sleep wakeup of CYW54907.

13. CYW54907 Power Signals for Unused Interfaces

Hardware

Connect the following power signals to GND when the associated interface is not used.

VDDIO_SD
VDDIO_AUDIO
USB_VDD_3V3
VDDIO_RMII

4.2 User Switches

There are two user switches available on the board named USER_1 and USER_2. Table 4-2 shows

the pin names and enumeration used in WICED for the switches.

Table 4-2. User Switch available on the board

. CYW54907 Pin Alternate Enumeration in
Switch Name WICED_ENUM_ID WICED
USER_1 (SW3) PWM_5 WICED_GPIO_18 WICED_BUTTONH1
USER_2 (SW1) GPIO_8 WICED_GPIO 4 WICED_BUTTON2

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A
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Figure 4-9. User Switch Circuit Diagram

+3V3

Hardware

+3V3
Q
SW1
Silkscreen: R168 ! 3 i ]
"Uzer 1" 10K fele [ g g ™1 .GRIOA
DERGIF £ P! B3S-1000
SW3 g ’
3 U . 1
4 3 g 2 T pPwMm5
- B3S-1000
4.3 LED
There are two user LEDs available named LED_1 and LED_2. Table 4-3 shows the pin name and
enumeration used in WICED for these LEDs.
Table 4-3. User LED Available on the Board
Switch CYWS54907 Pin Name WICED_ENUM_ID PAIITELD [E TG
WICED
LED_1 PWM_3 WICED_GPIO_16 WICED_LED1
LED 2 GPIO 9 WICED_GPIO 5 WICED_LED2
Figure 4-10. User LED Circuit Diagram
Silkscreen:
"LE D_1 2 +3V3
0
— D6 RED R166 150
- o, AN
i D7 GREEN R167 150
— 77 AN
Silkscreen:
"LED_Z"
4.4 Reset Control

CYW54907 device can be reset using the "Target Reset" switch SW2 or a reset command from the
on-board programmer/debugger and serial interface chip, as shown in Figure 4-11. The CYW54907/
BCM54907 datasheet states that HIB_REG_ON_IN needs to be delayed by at least 2 cycles of the
32.768-kHz clock after VBAT and VDDIO have reached 90% of their final values. To ensure proper
bootup, the RC delay circuit for HIB_REG_ON_IN is essential as shown in Figure 4-12. See
Bootstrap and Control Pins on page 28 for details on RC Delay Circuit.
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Figure 4-11. Reset Circuit Diagram

Target Reset

+3V3

ol +3V3
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4 RESET N

SORESET_N 5,89
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c24
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Figure 4-12. HIB_REG_ON_IN RC Delay Circuit

WLAN_VDDIO
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R152
33K

cos5 R153
[ 0.1uF M

HIB_REG_ON_IN
L

4.5 Ethernet

The Ethernet MAC Controller in the CYW54907 interfaces to an external PHY chip BCM5241 using
the Media Independent Interface (MIl) as shown in Figure 4-13. The same signals are also listed in
Table 4-4. CYW54907 also supports Reduced Media Independent Interface (RMII). The controller
can transmit and receive data at 10 Mbps and 100 Mbps.

Table 4-4. CYW54907 EMAC to PHY Chip Connection

SL.NO CYW54907 Pin Name Net Name in Schematic BCM5241 Pin Name
1 RMII_G_RXC MII_RXC RXC
2 RMII_G_COL MIl_COL COL/ENERGYDET
3 RMII_G_CRS MII_CRS CRS/STANDBY
4 RMII_G_TXC MII_TXC_RMII_REF_CLK TXC
5 RMII_G_TXDO0 MII_TXDO TXDO
6 RMII_G_TXD1 MII_TXD1 TXD1
7 RMII_G_TXD2 MII_TXD2 TXD2
8 RMII_G_TXD3 MII_TXD3 TXD3
9 RMII_G_RXDO MII_RXDO RXDO/PHYADO
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Table 4-4. CYW54907 EMAC to PHY Chip Connection (continued)

Hardware

SL. NO CYW54907 Pin Name Net Name in Schematic BCM5241 Pin Name
10 RMII_G_RXD1 MII_RXD1 RXD1/ANEN_L
11 RMII_G_RXD2 MII_RXD2 RXD2/F100
12 RMII_G_RXD3 MII_RXD3 RXD3/ISOLATE
13 RMII_MDIO MII_MDIO MDIO
14 RMII_MDC MIl_MDC MDC
15 RMII_G_TXEN MII_TXEN TXEN
16 RMII_G_RXDV MII_RXDV_CRS_DV RXDV
17 PWM_2 PWM_2 RESET_L

Figure 4-13. Ethernet MAC Controller to External PHY Connection

10K
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5 MI_TXD1 Sy MILTXD1 26 | 1xp1
5 MI_TXD2 Sy MILTXD2 27 xp2
5 MI_TXD3 Sy MILTXD3 2 | xp3
0.001uF
cs1 | [pepop |,
5 MLRXC (MILRXC B53, 38 MIRXCR 20|
5 MILRXDV_CRS_Dv((MILRXDV_CRS DV Re3 83 MIRXDVR 19|
§ MI_RXDO ((—MIL RXDO R64 \ 33 WMILRXDOR 18 | o xpoipHYADD
§ MI_RXD1 —MILRXD1 RE7 A\ n33 MILRXDLR 17 ] oxp1/aNeN L
5 MI_RXD2 (- MILRXD2 RT3 33 WIRXDZR 16 | exp2Fio0
§ MI_RXD3 (—MILRXD3 R4 33 MIRXDIR 15 | oXD3ISOLATE
RXER 21| e
5 MI_CRS (- MILERS RIB AL MLERSR 30 | os/sTANDBY
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4.6 Micro SD Connector/Slot
Micro SD connector is connected to the SDIO Interface of CYW54907. CYW54907 supports both
SDIO 3.0 Host and device modes. Figure 4-14 shows the interface between Micro SD connector and
CYW54907. These signals are listed in Table 4-5.
Table 4-5. Micro SD Connector signals
SL.No CYW54907 Based SIP Pin Name Micro SD Connector/Slot Name
1 SDIO_DATA_0 DATO
2 SDIO_DATA 1 DAT1
3 SDIO_DATA_2 DAT2
4 SDIO_DATA_3 CD/DAT3
5 SDIO_CMD CMD
6 SDIO_CLK CLK
7 PWM_0 DETECT
Figure 4-14. Micro SD Connector Circuit Diagram
- -'- f - — - 7
g || e
1ar s I | . ' 1
_ soio. 0 L4 i
4.7 JTAG Connector
4.7.1 On-board Programmer/Debugger and Serial Interface Chip

The on-board programmer/debugger chip uses JTAG to program/debug CYW54907-based SiP
module.

Table 4-6 shows the connection between CYW54907 and On-board Programmer/Debugger chip. In
addition to the connections listed in the table, JTAG_SEL and GPIO_8 TAP_SEL lines have been
pulled high to make sure programming/debugging is enabled through JTAG in CYW54907.

Table 4-6. Connection between CYW54907 and On-board Programmer/Debugger

SL. No CYW54907 Based SIP Pin Name (ST M 2 AV
Connection
1 GPIO_2 JTAG_TCK FTDI_JTAG_TCK
2 GPIO_3_JTAG_TMS FTDI_JTAG_TMS
3 GPIO_4_JTAG_TDI FTDI_JTAG_TDI
4 GPIO_5_JTAG_TDO FTDI_JTAG_TDO
5 GPIO_6_JTAG_TRST L FTDI_JTAG_TRST
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472 External JTAG

To use the External JTAG connector (J3), set all positions in switch SW4 to closed and connect your
external JTAG debugger. Ensure that the drivers for the debugger hardware are installed in the
same PC where WICED Studio is installed. When using Olimex connectors, for example
Olimex_ARM-USB-TINY-H, add "JTAG=0Olimex_ARM-USB-TINY- H" in your make target to debug.
Figure 4-15 shows the relevant part of the schematic for connecting an External JTAG device.
Figure 4-16 shows the connection between Olimex and the CYW954907AEVAL1F EVK.

Figure 4-15. External JTAG Connector Circuit Diagram
SW4 J3

FTDI JTAG TRST 1 " 12 GPIO 6 JTAG TRST N 1 2
FTDT JTAG TDT 7 112 TGP0 2 _JTAG TDI 712 O3
32— 1 [0 GPID 5 JTAG_TDO 510 O75
—FTOrITAG TMS 4] 3— 10 [ 'g TGP0 3 JTAG TNS Y d O
BEIcE 4—"— 9 g TGP0 7 JTAG TCK 512 B0
FTOT JTAG. TCR
L Hs—— s |5 R 0 o
TSM-105-02-8-DV
AGH6107 AL

JTAG HEADER E—
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4.8 Connectors

4.8.1 WICED Header
J6 is the WICED header available on CYW954907AEVAL1F EVK. This is a 44-pin header containing
I12C, SDIO, UART, SPI, PWM lines, and I/Os. Note that some signals are shared with Arduino header
(UARTO Tx/Rx) and On-board Programmer/debugger chip (UART1). Table 4-7 illustrates the J6
pinout.
Table 4-7. WICED Header Pinout

Ev:LaBdc;a"rd CYW54907 Pin Name WICED Enumeration Alternate Enumeration

J6.1 PWM 4 WICED_GPIO_17 WICED_PWM_5

J6.2 PWM_5 WICED_GPIO_18 WICED_BUTTON"1

J6.3 12S0_MCK WICED_GPIO_28 WICED_12S_1

J6.4 12S0_SD_OUT WICED_GPIO_32 WICED_I2S_1

J6.5 1250_SCK_BCLK WICED_GPIO_29 WICED_12S_1

J6.6 12S0_WS_LRCLK WICED_GPIO_30 WICED_I2S_1

J6.7 PWM_3 WICED_GPIO_16 WICED_LED1

J6.8 GND N/A N/A

J6.9 SPI_1_CLK WICED_GPIO_38 WICED_SPI 2

J6.10 12S1_SD_OUT WICED_GPIO_37 WICED_I2S_3

J6.11 SPI_1_MISO WICED_GPIO_39 WICED_SPI_2

J6.12 SPI_0_CLK WICED_GPIO_20 WICED_SPI_1

J6.13 SPI_1_MOSI WICED_GPIO_40 WICED_SPI_2

J6.14 SPI_0_MOSI WICED_GPIO_21 WICED_SPI_1

J6.15 SPI_1.CS WICED_GPIO 41 WICED_SPI_2

J6.16 SPI_0_CS WICED_GPIO_22 WICED_SPI_1

J6.17 SPI_0_MISO WICED_GPIO_19 WICED_SPI_1

J6.18 UARTO_RXD_IN WICED_PERIPHERAL_PIN_3 WICED_UART 2

J6.19 GND N/A N/A

J6.20 UARTO_TXD_OUT WICED_PERIPHERAL_PIN_4 WICED_UART_2

J6.21 USB2_HOST DEV_SEL N/A N/A

J6.22 UARTO_CTS_IN WICED_PERIPHERAL_PIN_5 WICED_UART 2

J6.23 I2C_0_SCL WICED_GPIO_49 WICED_I2C_1

J6.24 UARTO_RTS_OUT WICED_PERIPHERAL_PIN_6 WICED_UART_2

J6.25 I2C_0_SDA WICED_GPIO_48 WICED_I2C_1

J6.26 12S1_MCK WICED_GPIO_33 WICED_I2S_3

J6.27 1281 _WS_LRCLK WICED_GPIO_35 WICED_12S_3

J6.28 GND N/A N/A

J6.29 1281_SCK_BCLK WICED_GPIO_34 WICED_12S_3

J6.30 SDIO_DATA_1 WICED_GPIO_45 N/A

J6.31 SDIO_DATA 0 WICED_GPIO_44 N/A

J6.32 SDIO_CLK WICED_GPIO_42 N/A
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Table 4-7. WICED Header Pinout (continued)

EV:L;ZT“ CYW54907 Pin Name WICED Enumeration Alternate Enumeration
J6.33 SDIO_CMD WICED_GPIO_43 N/A

J6.34 SDIO_DATA_3 WICED_GPIO_47 N/A

J6.35 SDIO_DATA 2 WICED_GPIO_46 N/A

J6.36 RF_SW_CTRL_6_UART1_RXD WICED_PERIPHERAL_PIN_1 WICED_UART _1

J6.37 UART1_TXD WICED_PERIPHERAL PIN_2 WICED_UART _1

J6.38 RF_SW_CTRL_8 UART2_RXD WICED_PERIPHERAL_PIN_7 WICED_UART_3

J6.39 UART2_TXD WICED_PERIPHERAL PIN_8 WICED_UART_3

J6.40 HIB_WAKE N/A N/A

J6.41 HIB_LPO_ SEL N/A N/A

J6.42 HIB_REG_ON_IN N/A N/A

J6.43 USB2_ DN N/A N/A

J6.44 UsB2_DP N/A N/A
4.8.2 Arduino-Compatible Headers

J9, J13, J12 and J10 are the Arduino headers available in the CYW954907AEVAL1F EVK. Table 4-8
shows the pinout of the Arduino Header. Note the following while connecting an Arduino shield to the
board:

5V pin of Header (J9) is not connected to the board.

The maximum current that an Arduino shield can sink from the board depends on the application
that is running. In general, 100 mA is the worst-case scenario.

The Arduino Analog reference is connected to the 3V3 (3.3V) power supply through R21, which
is not populated by default. In other words, the analog reference is not driven by default.

An external ADC attached to CYW54907 helps to achieve analog functionality on the Arduino

headers.

Table 4-8. Arduino Header Pinout

Eval Board CYV\{549-)07 Pin Name/ ARDUINO WICED Enumeration Alternat_e
Header Kit Signal Name Header Name Enumeration

J10.1 GPIO_0 DO N/A
J10.2 GPIO_1 D1 N/A
J10.3 GPIO_13 D2 N/A
J10.4 GPIO_7 D3 WICED_PWM_6
J10.5 GPIO_14 D4 N/A
J10.6 GPIO_16 D5 WICED_PWM_3
J10.7 GPIO_15 D6 WICED_PWM_4
J10.8 12S0_SD_IN D7 WICED_I2S_1
J12.1 12S1_SD_IN D8 WICED_I2S_3
J12.2 PWM_4 D9 WICED_PWM_5
J12.3 GPIO_11 D10 WICED_PWM_2
J12.4 GPIO_10 D11 WICED_PWM_1
J12.5 GPIO_12 D12 N/A
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Table 4-8. Arduino Header Pinout (continued)
Eval Board CYV\{54.‘.JO7 Pin Name/ ARDUINO WICED Enumeration AIternat_e
Header Kit Signal Name Header Name Enumeration

J12.6 GPIO_9 D13 WICED_LED2
J12.7 GND GND N/A

J12.8 ARD_AREF AREF N/A

J12.9 12C_1_SDA SDA WICED_I2C_2
J12.10 12C_1_SCL SCL WICED_I2C_2
J13.1 ARD_ADO A0 N/A

J13.2 ARD_AD1 A1 N/A

J13.3 ARD_AD2 A2 N/A

J13.4 ARD_AD3 A3 N/A

J13.5 ARD_AD4_SDA Ad N/A

J13.6 ARD_AD5_SCL A5 N/A

Ja.1 NC NC N/A

J9.2 ARD_IOREF IOREF N/A

Ja.3 ARD_RESET RESET N/A

J9.4 3V3 3.3V N/A

J9.5 NC 5V N/A

J9.6 GND GND N/A

Jo9.7 GND GND N/A

J9.8 VIN_EXT VIN N/A
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4.9 UART Port Configuration on CYW954907AEVAL1F Kit
CYW54907 has three UART ports: slow UART, fast UART, and GCI UART. Slow UART and GClI
UART are 2-wire interfaces, while fast UART is a 4-wire interface that can support up to a 3-Mbps
baud rate. Slow UART is routed to the on-board programmer/debugger chip for UART-to-USB
communication. The UART peripherals are defined in platforms/CYW954907AEVAL1F/platform.c.
Following table (also available in platforms/CYW954907AEVAL 1F/platform.h) shows the UART pins
available on the kit.
WICED Peripheral Pin Name on ALl WICED
Enumeration ID CYW54907 LA AU T U T Pin Enumeration
Number
WICED_PERIPHERAL_PIN_2 |RF_SW_CTRL_7 |RF_SW_CTRL_7_UART1_TXD |J6:37 WICED_UART_1
WICED_PERIPHERAL_PIN_3 |UARTO_RXD UARTO_RXD_IN J6:18 WICED_UART_2
WICED_PERIPHERAL_PIN_4 |UARTO_TXD UARTO_TXD_OUT J6:20 WICED_UART_2
WICED_PERIPHERAL_PIN_5 |UARTO_CTS UARTO_CTS_IN J6:22 WICED_UART_2
WICED_PERIPHERAL_PIN_6 |UARTO_RTS UARTO_RTS_OUT J6:24 WICED_UART_2
WICED_PERIPHERAL_PIN_7 |RF_SW_CTRL_8 |RF_SW_CTRL_8_UART2_RXD |J6:38 WICED_UART_3
WICED_PERIPHERAL_PIN_8 |RF_SW_CTRL_9 |RF_SW_CTRL_9_UART2_TXD |J6:39 WICED_UART_3
410 External ADC
CYW54907 does not have an in-built ADC block. Analog measurements from the Arduino header
analog pins is achieved using an external ADC chip (MAX11615) connected to CYW54907 through
an 12C interface (12C_0 module-Slave Address 0x33). Table 4-9 lists the connections between
CYW54907 and the external ADC Circuit diagram is shown in Figure 4-17.
Table 4-9. External ADC Connection
12C Line CYW54907 Pin Name WICED Enumeration Alternate Enumeration
SDA I2C_0_SDA WICED_GPIO_48 WICED_I2C_1
SCL 12C_0_SCL WICED_GPIO_49 WICED_I2C_1
Figure 4-17. External ADC Circuit Diagram
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4.11 PWM

There are six dedicated PWM outputs available on CYW54907. These PWMs can be multiplexed
onto different pins. You can find their definitions in platforms/CYW954907AE VAL 1F/platform.c inside
WICED Studio.

The PWMs can be reassigned to other pins by changing the first argument of the plat form pwm_ t
platform_pwm_peripherals structure in platform.c. Table 4-10 through Table 4-15 show the
possible combinations and their Arduino header locations.

Table 4-10. WICED_PWM_1 Combinations

Pin MUX Selection Header Pin Header Name
PIN_GPIO_10 (DEFAULT) J12.4 Arduino D11 (MOSI)
PIN_GPIO_0 J10.1 Arduino DO
PIN_GPIO_8 - -

PIN_GPIO_12 J12.5 Arduino D12 (MISO)
PIN_GPIO_14 - -

PIN_GPIO_16 J10.6 Arduino D5
PIN_PWM_0 - -

Table 4-11. WICED_PWM_2 Combinations

Pin MUX Selection Header Pin Header Name
PIN_GPIO_11 (DEFAULT) J12.3 Arduino D10
PIN_GPIO_1 J10.1 Arduino DO
PIN_GPIO_7 J10.4 Arduino D3
PIN_GPIO_9 J12.9 Arduino SCK
PIN_GPIO_13 J10.3 Arduino D2
PIN_GPIO_15 J10.7 Arduino D6
PIN_PWM_1 - -

Table 4-12. WICED_PWM_3 Combinations

Pin MUX Selection Header Pin Header Name
PIN_GPIO_16 (DEFAULT) J10.6 Arduino D5
PIN_GPIO_8 - -

PIN_GPIO_0O J10.1 Arduino DO
PIN_GPIO_10 J12.4 Arduino D11 (MOSI)
PIN_GPIO_12 J12.5 Arduino D12 (MISO)
PIN_GPIO_14 - -

PIN_PWM_2 - -
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Table 4-13. WICED_PWM_4 Combinations

Pin MUX Selection Header Pin Header Name
PIN_GPIO_15 (DEFAULT) J10.7 Arduino D6
PIN_GPIO_1 J10.1 Arduino DO
PIN_GPIO_7 J10.4 Arduino D3
PIN_GPIO_9 J12.9 Arduino SCK
PIN_GPIO_11 J12.3 Arduino D10
PIN_GPIO_13 J10.3 Arduino D2
PIN_PWM_3 - -

Table 4-14. WICED_PWM_5 Combinations

Pin MUX Selection Header Pin Header Name

PIN_PWM_4 (DEFAULT) J6.1 Arduino A1
PIN_GPIO_O0 J10.1 Arduino DO
PIN_GPIO_8 - -

PIN_GPIO_10 J12.4 Arduino D11 (MOSI)
PIN_GPIO_12 J12.5 Arduino D12 (MISO)
PIN_GPIO_14 - -

PIN_GPIO_16 J10.6 Arduino D5

Table 4-15. WICED_PWM_6 Combinations

Pin MUX Selection Header Pin Header Name

PIN_GPIO_7 (DEFAULT) J10.4.4 Arduino D3
PIN_GPIO_1 J10.1 Arduino DO
PIN_GPIO_9 J12.9 Arduino SCK
PIN_GPIO_11 J12.3 Arduino D10
PIN_GPIO_13 J10.3 Arduino D2
PIN_GPIO_15 J10.7 Arduino D6
PIN_PWM_5 - -
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This chapter demonstrates the functionality of CYW54907 devices using the CYW954907AEVAL1F
EVK code examples. Download and extract the zip file from the CYW954907AEVAL1F EVK web
page as specified in the Software Installation section. The code examples once unzipped can be
viewed in WICED Studio 6.0 (or later). In addition to the added examples, there are already many
apps (snip.gpio, test.console, and so on) that are available in WICED Studio 6.0.

5.1 Using Code Examples

Code examples already added can be compiled after creating Make Targets. See Building and
Programming a Project in WICED Studio IDE for the process of creating targets.
Create the following three make targets in WICED Studio 6.0 (or later):

B “snip.gpio-CYW954907AEVALL1F download run" for the gpio example which is already
present in WICED Studio.

B “kits.CYW954907AEVALLF.config join_ping-CYW954907AEVALLF download run"
for the config_join_ping project.

B “kits.CYW954907AEVALLF.publish_subscribe_aws-CYW954907AEVALIF download
run" for the aws publish and subscribe project.

B “kits.CYW954907AEVALLIF.adc_measure-CYW954907AEVALIF download run" for the
adc_measure project.

5.2 GPIO

5.2.1 Project Description

The gpio project demonstrates toggling of LEDs and turning them off when one of the user switches
is pressed.

The gpio project consists of the following files:

m gpio.c: Contains the main application function application_start(), which is the entry point and
execution of the firmware application.

m gpio.mK: This is the makefile that adds the source of the application.

522 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the CYW954907AEVAL1F EVK.
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5.2.3 Verify Output

Do the following to verify the output:

1. Create and run a make target for the gpio project using the description specified in Building and
Programming a Project in WICED Studio IDE.
After initialization of the platform, LEDs will keep flashing (toggling). When a user switch is
pressed, the corresponding LED turns off. The example also prints a message to the debug
UART at startup.

2. Open aterminal emulation program and connect to the WICED serial port as detailed in Step 8 in
the section UART Port Configuration on CYW954907AEVAL1F Kit.

5.3 Config_join_ping

5.3.1 Project Description

The config_join_ping project demonstrates connectivity between CYW954907AEVAL1F EVK
and a Wi-Fi access point. This example is based on existing examples available in the WICED
Studio 6.0 (or later) SDK namely, apps/snip/scan, apps/snip/dct read write and test/console. On
startup, this application shows a console through which you can enter commands to scan, configure,
join, and ping Wi-Fi access points.

The config_join_ping project consists of the following files:

m config_join_ping.c: This file contains the main application function application_start() which is
the entry point and execution of the firmware application. It also contains the function definitions
for joining, pinging, printing Wi-Fi configuration, scanning Wi-Fi and the scan result handler.

m config_join_ping.mk: This is the makefile which adds the sources, components (in this
application, console and ping are used), and the name of the application. Note that the name of
the makefile must match the name of the project folder for the make process to work properly.
Also, the "NAME" string in the makefile must be unique among all projects in the apps folder.

532 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the CYW954907AEVAL1F EVK.
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5.3.3 Flowchart
Figure 5-1 illustrates the config_join_ping flowchart.

Figure 5-1. config_join_ping Flowchart
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534 Verify Output

Do the following to verify the output:

1. Create and run a make target for the config_join_ping project using the description
specified in Building and Programming a Project in WICED Studio IDE.

2. Open a Terminal Emulation program and connect to the WICED serial port as detailed in Atep 8

in the section UART Port Configuration on CYW954907AEVAL1F Kit.

After initialization of the platform, Wi-Fi and other components, the cursor will stop and wait for

you to enter commands.
3. Type the help command to see the list of available commands as shown in Figure 5-2.
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Figure 5-2. Initial Console Output

66:55:44:33:22:27
! wl@: Oct 23 2017 B3:40:42 version 7.15.168.181 (r674438)
A1-13caell
HLAN CLM

ation: 2817—13—2& A3:36:41

ype help to know more about commands ...

help
onsole Commands:
?

help [<command? [<{example_num>11]
— Print help message or command example.
loop <times?> <semicolon_separated_commands_list>
- — Loops the specified commands for specified number of times.
— Print return value of last executed command.
config <8TA name and pass key>
— adds AP settings to DCT
Join
— Joins station set in DCT
print_config
— prints current wifi configuration
scan
— prints current wifi configuration
ping <{ip address>
— pings wifi configuration
disconnect
— Dis—connects from AP

API: 12.2 Data: 2.18.74 Compiler: 1.31.3 Clmlmport: 1.36.

FWID
3 Cr

Code Examples

4. Type the command scan to find the list of available Wi-Fi access points as shown in Figure 5-3.
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Figure 5-3. Scan Output
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5. Type the command config <SSID> <password> . This command writes the given
configuration in the Device Configuration Table (DCT). These values are stored in flash memory

on the board.

6. Type the command print_config to validate if the SSID and password match and are
appropriately written in the DCT.

7. Type the command join. The join command joins the network specified by the SSID and
password from the DCT. Ping the Access point (usually 192.168.1.1) or 8.8.8.8 (IP address of
Google, if your AP is connected to internet) and check if the network is up and responding. The
message "Ping Reply 1llms" is displayed as shown in Figure 5-4.

CYW954907AEVAL1F Evaluation Kit User Guide, Document Number: 002-22338 Rev. *A

49



" CYPRESS Code Examples

EMBEDDED IN TOMORROW

Figure 5-4. Join and Ping

T COM4 - Tera Term VT o £ >

File Edit Setup Control Window Help

> Join

Joining : CY-IOT-HOTSPOT
Bucceszfully joined : CY-IOT-HOTSPOT
Obtaining IPvd4 address via DHCP
DHCP CLIENT hostname WICED IP

dre
IPv6 network ready IP: FESP:PPPA:0000:0000:6455:44FF:FE33:2227
> ping 18.48.2 .1
PING 1@.468.2.1
Plng Reply 18ms

18.48.2 .1 ping statistics ——

1 packets transmitted., 1 received. 8% packet loss. time 18ms
§tt minsavg/maxsmdev = 18/18.8-18-8 ms

8. To disconnect from the access point, use the disconnect command.

The console component maintains a history of commands typed, which can be accessed using the
Up/Down arrow keys.
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54 ADC_measure

5.4.1 Project Description

This project demonstrates measuring values from the external ADC chip on the board and posting
the values to a web page accessible from the WLAN network. This code example is based on
existing code example (apps/demo/temp_control) available in the WICED Studio 6.0 (or later). On
startup, the adc_measure code example joins the Wi-Fi Access Point specified in the
wifi_config_dct.h file and starts a web page where the ADC count is reported.

The project consists of the following files:

m adc_measure.c: This file contains the main application function application_start() which is the
entry point and execution of the firmware application. It also contains the function definitions for
initializing, conducting ADC measurement, starting the web page, and processing an ADC
update.

m adc_measure.mk: This is the makefile which adds the sources, components (in this application,
component HTTP_server, device_configuration, Xively, SNTP, and Gedday are used) and the
name of the application. It also adds the required resources for the web page which is available in
the resources/apps directory.

m /2c.c: This file contains the required function definitions for initializing and taking ADC samples
from the external ADC (MAX 11615) available in the CY9W54907AEVAL1F EVK.

m  wifi_config_dct.h: This file contains the Wi-Fi Access Point credentials (SSID and pass phrase
key) and soft AP credentials. Enter the client access point name and password credentials prior
to building the application. These are specified as CLIENT_AP_SSID and
CLIENT_AP_PASSPHRASE. Note that the security type may also have to be changed if the
access point does not use WPA2 security. The Wi-Fi access point must be connected to the
internet to get the current time using Network Time protocol (NTP). If the Wi-Fi access point is not
connected to the internet, then it will assume 00:00:00 UTC time and will start the web page.
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542 Hardware Connections

Connect a potentiometer (10 kQ) between VCC and GND with the center terminal connected to
channel 1 of the ADC (pin A1 in the Arduino header) as shown in Figure 5-5. If you do not have a
potentiometer to test, you can connect a wire between VCC and ADC channel 2 (to simulate full
scale) or a wire between GND and ADC channel 1 (to simulate zero scale). Alternately, you can
connect an adjustable DC power supply to ADC channel 1.

Figure 5-5. Potentiometer Connection
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543 Flowchart

Figure 5-6. adc_measure Flowchart
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544 Access Point Credentials

1. Enter your credentials (SSID and pass phrase key) in the wifi_config_dct.h file.
2. Update the following macros:

0 CLIENT_AP_SSID: update with your access point's SSID

O CLIENT_AP_PASSPHRASE: update with your access point's pass phrase key

0 CLIENT_AP_SECURITY: update with the security type of your access point.
This is "WICED_SECURITY_WPA2 _MIXED _PSK"if the access point uses WPA2-PSK. If the
AP uses a different security mechanism, choose the correct one defined in enum wiced_se-
curity_t from 43xxx_Wi-Fi\WICED\WWD\include\wwd_constants.h.

54.5 Verify Output

1. Create and run a make target for the adc_measure project similar to the procedure provided in
Building and Programming a Project in WICED Studio IDE.

2. If connection to the Wi-Fi access point is successful, wait for NTP time request to complete.
The output of the terminal program should be similar to the screenshot in Figure 5-7.

Figure 5-7. NTP Success

7 COM4 - Tera Term VT o d x
File Edit Setup Control Window Help

Starting WIGED vWiced_ 006 .000.800.08043
Platform CYWIS54287AEVALLF initialised

Creating Packet pools

WLAN MAC Address = 66:55:44:33:22:27

H%gH F%;muare : wlB: Oct 23 2817 B3:48:42 version 7.15.168.181 <(r674438> FWID 81
—13cae

WLAN CLM : API: 12.2 Data: 9.18.74 Compiler: 1.31_3 ClmImport: 1.36.3 Creat
ion: 2817-18-23 B3:36:41

I2C Initialization

12C Device Probe

I12C Device Connected at address: Bx33

Sending ADC setup bhuyte

Joining @ CY-IOT-HOTSPOT

Successfully joined : CY-IOT-HOTSPOT

Obtaining IPu4 address via DHGP
DHCP CLIENT hostname WICED TP
rveady IP: 18.48.2.134
link-local address
ready IP: FESA:0000:0000:0000:6455:44FF:FE33:2227
is: 2817-11-23T86:-42:07.7000R0Z

3. Enter the IP address as the URL in your web browser, as shown in the terminal output in
Figure 5-7, such as 10.40.2.134.
The browser will show the output as shown in Figure 5-8. Note that the PC and
CYW954907AEVAL1F EVK should be connected to the same access point.

4. Rotate the potentiometer and verify that the value shown on web page changes accordingly.
One easy way to validate the correct functioning is to rotate the potentiometer to one of the
extremes and observe if the full-scale value appears. If you do not have access to a
potentiometer, you can use an adjustable power supply or wires to connect 3.3V and GND to the
ADC input alternatively.
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Figure 5-8. Webpage

Edit View History Bookmarks Tools Help

ress WICED ADC Measuring Ap X

C w U 10.40.2.134 ; st ain.ht - @ W X § ¥ INn @ =

# vrress WICED™ ADC Measuring Application

Current Time : 06:44:42 UTC
Current Date : 2017-11-23 UTC
Current POT Value : 23 counts in ADC and 0.019 mV

5.5

5.5.1

Publish_subscribe_aws

Project Description

This project demonstrates publishing a message to a Thing in the Amazon Web Services (AWS)
cloud and subscribing to the same messages. A Thing is a representation of a specific device or

logical entity. For more information, refer to the AWS Documentation.

This example is based on existing code example (apps/aws_iot/publish and apps/aws_ iot/
subscribe.) available in WICED Studio 6.0 (or later). On startup, the publish_subscribe_aws code
example joins a Wi-Fi access point specified in the wifi_config dct.h file, connects to AWS,
subscribes to the specified topic and then alternately tries to publish LIGHT ON and LIGHT OFF

messages.

The project consists of the following files:

m publish_subscribe.c: This file contains the main application function application_start(), which is
the entry point and execution of the firmware application. It also contains the function definitions

for initializing, publishing and subscribing to AWS.

m publish_subscribe _aws.mk: This is the makefile which adds the sources, protocols, components
(in this application, the MQTT component is used) and the name of the application. It also adds
the required resources for the web page which are available in the resources/apps directory. Note

that this project uses certificates from apps/aws_iot directory.

m wifi_config_dct.h: This file contains the Wi-Fi access point credentials (SSID and pass phrase

key) and soft AP credentials. You should enter the client access point name and password
credentials prior to building the application. These are specified as CLIENT_AP_SSID and
CLIENT_AP_PASSPHRASE. Note that the security type may also have to be changed if the
access point does not use WPA2 security. The Wi-Fi access point must have access to the
internet to connect with AWS.
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552 Hardware Connections

No specific hardware connections are required for this project because all connections are
hardwired on the CYW954907AEVAL1F EVK.

553 Flowchart

( Initialize WLAN 3 No

J

Certificates
and key valid?

Bring up the WLAN interface
and connect to MQTT Broker

Error?

>
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No
Open the connection, subscribe to
P messages, and publish messages
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exceed retry count?
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554 Verify Output

5.5.4.1 Set up an AWS Account and Create a Thing, Policy, and Certificate

An AWS account allows you to view AWS account activity, view usage reports, and manage AWS
Security Credentials. When you sign up for AWS, your AWS account is automatically signed up for
all services in AWS, including AWS loT. You are charged only for the services that you use.

For more information about AWS loT, see the help pages of AWS here.

Do the following to set up a new account:

1.
2.

Open https://aws.amazon.com and choose Create an AWS Account.

Follow the online instructions. Part of the sign-up procedure involves receiving a phone call and
entering a PIN using the phone keypad.

In the Console Home page, select your AWS Region (in this example Asia pacific (Singapore) is
used), and choose the AWS loT service. The AWS loT Console window appears.

Create a Thing

1.

In the AWS IoT Console window, choose Manage > Things on the left-hand panel, and then
click Create as shown in Figure 5-9.

Figure 5-9. Create Thing
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2. Each Thing is uniquely identified by its name. Assign a name in the Name field, and click Create
thing. For example, “54907_aws”.

Note: It is possible to exchange messages without a need to create a thing (by having a
certificate with an attached policy), but it is recommended by AWS to create it.

&

Register a thing

This step creates an entry in the thing registry and a thing shadow for your device.

Name

54907 _aws)|

Show optional configuration (this can be done later) ~

Create thing

3. In the created Thing window, click the left arrow to navigate back to the AWS loT Console
window.

Create a Policy

1. Inthe AWS loT Console window, go to Secure > Policies, and then click the Create button. The
Create a policy window appears.

File Edit View Higtory Bookmarks Took Help

B AWS loT

€« ¢ @ @ & httpsy/ap-southeast-1.console.aws.amazon.com/iotv2/! o @ | | Q Searct in @ =

aWS Services « Resource Groups + * JAY Sheetal Jonwal ~ ingapore ~ Support *

&P aws io1 Policies Card ~ m =

try

@ Secure

Policies

1

o
o

)

R
®
&
@) Learr v

Feedback (3 English (US)

2. Assign a policy name in the Name field. For example, “564907_policy”.
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3. In Add statement, specify the Action as iot:*.

4. Assign an Amazon Resource Name (ARN) in the Resource ARN field. To use a wild card,
change the last part of Resource ARN as follows:
"arn:aws:iot:us—east-1:xXXxXXXxXXXxXxX:topic/replaceWithATopic"
to
"arn:aws:iot:us—east—1:XXXXXXXXXXXX:*

Notes:

m Use the region that you selected when you set up your account.

5.

Replace xxxxxxxxxxxx with the appropriate value for your ARN.

In the ARN name, ensure that you change "topic/replaceWithATopic" to ™", where
indicates all topics. If you want to use the certificates only for a specific topic (in this case,
"54907_led_onoff" is the one defined as WICED_TOPIC macro in publish_subscribe.c ), use

the following Resource ARN:
"arn:aws:iot:us-east-1:xxxxxxxxxxxx:54907_led_onoff".

Select the Allow Effect check box and then click the Create button as shown in Figure 5-10.

In the created policy window, navigate back to the AWS loT Console window.

nkn nien

Figure 5-10. Create Policy
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Create a Certificate for a Thing

1. Inthe AWS IoT Console window, go to Manage > Things, and then click the created Thing (for
example: 54907_aws).
The created Thing window appears.

2. In the left navigation pane, click Security and then click Create certificate.

Figure 5-11. Create Certificate

File Edit View History Bookmarks Tools Help
@ AWS loT +
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thing stablisk

13 Secure conne

T
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3. On the Certificate created page, click the Download button for the certificate and private key to
save each of them to your PC.

Notes:

m The certificate and private key cannot be revisited later for download and must be saved while
creating the Certificate.

m Back up the existing <WICED-SDK>\43xxx_Wi-Fi\resources\apps\aws_iot\client.cer and rename
the downloaded certificate as client.cerin <WICED-SDK>\43xxx_Wi-Filresources\apps\aws_iot\.

m Back up the existing <WICED-SDK>\43xxx_Wi-Fi\resources\apps\aws_iot\privkey.cer and
rename the downloaded private key as privkey.cer in <WICED-SDK>\43xxx_Wi-
Fi\resources\apps\aws_iot\.
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4. Click the Activate button and then click the Attach a policy button as shown in Figure 5-12. The
Add authorization to certificate window appears (see Figure 5-13).

Figure 5-12. Activate and Attach policy
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5. Select the check box next to the policy you want to choose and then click Done.

Figure 5-13. Select Policy

=
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6. In the created policy window, click to navigate back to the AWS loT Console window.
7. Go to Security > Certificates. The Certificates window appears.

8. Click the created certificate. The Certificate ARN window appears.

9. Click Policies in the left-hand panel to validate if the correct policy is linked.

10. Click Things in the left-hand panel to validate if the correct Thing is linked.

11. Click the specific Thing. The Thing ARN window appears.
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12. In left navigation pane, choose Interact.
13. Copy the Endpoint from the HTTPS tab as shown in Figure 5-14

Figure 5-14. Endpoint.
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14. Navigate to the publish_subscribe.c file to update the MOTT_BROKER_ADDRESS macro with the
endpoint address copied from HTTPS tab. Remove the first string before "." in endpoint and
replace it with * and copy it to the REGION macro.

In this case, itis "*.iot.ap-southeast-1.amazonaws.com".

The created Thing, policy and certificate are used to interact with the AWS IloT.

5.5.4.2  Access Point Credentials
1. Enter your credentials (SSID and pass phrase key) in the wifi_config_dct.h file.
2. Update the following macros:

a

a

a

CLIENT_AP_SSID: update with your access point's SSID

CLIENT_AP_PASSPHRASE: update with your access point's pass phrase key
CLIENT_AP_SECURITY: update with the security type of your access point.

This is WICED_SECURITY _WPA2_MIXED_PSK if your access point uses WPA2-PSK. If your
AP uses different security then choose correct one defined in enum wiced_security_t
from 43xxx_Wi- FNWICED\WW0D\include\wwd constants.h.
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5.56.4.3 Build, Program, and Verify

Your Wi-Fi access point must be connected to the internet to verify the example.

1. Build and program the publish_subscribe_aws example using a similar procedure to the
one provided in Building, Programming, and Debugging.
Once programmed, the CYW954907AEVAL1F EVK will try to connect to AWS loT and subscribe
to the specified topic.

2. Press the switch USER _1to turn LED_1 ON and OFF alternately as shown in Figure 5-15. Note
that this is being done over the cloud. That is, pushing the switch publishes a message to the
cloud. The LED turns on in response to a notification from the cloud. You can also see observe
the messages inside the AWS console itself.

3. Inthe AWS loT Console window, go to Dashboard > Messages published to observe the
number of messages exchanged.

Figure 5-15. Publish_Subscribe Output
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4. Go to Test. Type a topic name and click on Subscribe to topic. Publish to the same topic.
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You will see the message published as follows in Monitor section.
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Figure 5-16. Messages Published
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